PASS Sample Size Software

NCSS.com

Chapter 378

Mixed Models Tests
for Two Proportions in
a 3-Level Hierarchical
Design (Level-2
Randomization)
Introduction
This procedure calculates power and sample size for a three-level hierarchical mixed-effects logistic regression
model which is randomized at the second level. The goal of the study is to compare two group proportions. The
study may be cross-sectional or longitudinal.
In a cross-sectional version of this design, students (first level units) are nested in classrooms (second level units)
which are nested in schools (third level units). Each school is randomized into one of two intervention groups;
e.g., treatment and control.
In a longitudinal version of this design, repeated measurements (first level units) are nested in patients (second
level units) which are nested in clinics (third level units). Each clinic is randomized into one of two intervention
groups; e.g., treatment and control.
Note that companion procedures analyze the other cases in which the randomization occurs at the first, or third,
level.
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Technical Details
Our formulation comes from Ahn, Heo, and Zhang (2015), chapter 6, section 6.7.2, pages 225-228. The
hierarchical mixed model used for the analysis is
log �
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is the binary response of the kth level-1 unit of the jth level-2 unit of the ith level-3 unit.
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is the fixed intercept.

is the treatment effect of interest. It is the difference between the two group proportions.

𝑋𝑋𝑖𝑖𝑖𝑖𝑖𝑖

is an indicator variable that is 1 if ith unit is in group 1 and 0 if it is in group 2.

𝑢𝑢𝑗𝑗(𝑖𝑖)

is the level-2 random intercept effect for the j(i)th level-2 unit. It is distributed as 𝑁𝑁(0, 𝜎𝜎22 ).

𝑢𝑢𝑖𝑖

is the level-3 random intercept effect for the ith level-3 unit. It is distributed as 𝑁𝑁(0, 𝜎𝜎32 ).

𝜌𝜌1

is the correlation among level-1 units which are in a particular level-2 unit. For fixed models like
this, 𝜌𝜌1 = 𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶�𝑌𝑌𝑖𝑖𝑖𝑖𝑖𝑖 , 𝑌𝑌𝑖𝑖𝑗𝑗𝑗𝑗 ′ � = (𝜎𝜎22 + 𝜎𝜎32 )/𝜎𝜎 2 .

C

is the number of level-3 units.

K1

is the number of level-2 units assigned to group 1.

K2

is the number of level-2 units assigned to group 2.

M

is the number of level-1 units per level-2 unit.

𝜌𝜌2

is the correlation among level-2 units which are in a particular level-3 unit. For fixed models like
this, 𝜌𝜌2 = 𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶�𝑌𝑌𝑖𝑖𝑖𝑖𝑖𝑖 , 𝑌𝑌𝑖𝑖𝑗𝑗′ 𝑘𝑘 ′ � = (𝜎𝜎32 )/𝜎𝜎 2 .

The test of significance of the Xijk term in the logistic model is the test statistic of interest. It tests the difference of
the two group proportions.
Assume that 𝛿𝛿 = 𝑝𝑝1 − 𝑝𝑝2 is to be tested using a z-test (large sample). The statistical hypotheses are 𝐻𝐻0 : 𝛿𝛿 = 0 vs.
𝐻𝐻𝑎𝑎 : 𝛿𝛿 ≠ 0. The test statistic is the regression coefficient of the Xijk term in a mixed model.
The power can be calculated using
𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 =

Φ�|𝑝𝑝1 − 𝑝𝑝2 |�𝐾𝐾2 𝐶𝐶𝐶𝐶/𝑓𝑓2 − Φ(1 − 𝛼𝛼/2)�(1 + 1/𝜆𝜆)𝑝𝑝̅ (1 − 𝑝𝑝̅ )�
�𝑝𝑝2 (1 − 𝑝𝑝2 ) + 𝑝𝑝1 (1 − 𝑝𝑝1 )/𝜆𝜆

where 𝜆𝜆 = 𝐾𝐾1 /𝐾𝐾2, 𝑝𝑝̅ = (𝐾𝐾1 𝑝𝑝1 + 𝐾𝐾2 𝑝𝑝2 )/(𝐾𝐾1 + 𝐾𝐾2 ), and 𝑓𝑓2 = 1 + (𝑀𝑀 − 1)𝜌𝜌1 − 𝑀𝑀𝜌𝜌2 .
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are Effect Size, Power, C, K1, and M.
Under most situations, you will select either Power to calculate power or K1 to calculate the number of level-2
unit2. Occasionally, you may want to fix K1 and K2 and calculate C or M.
Note that the value selected here always appears as the vertical axis on the charts.
The program is set up to calculate power directly. To find appropriate values of the other parameters, a binary
search is made using an iterative procedure until an appropriate value is found. This search considers only integer
values of C, K1, or M.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
If your only interest is in determining the appropriate sample size for a confidence interval, set power to 0.5.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected.
Values must be between zero and one. Usually, the value of 0.05 is used for alpha and this has become a standard.
This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha
that represents the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.
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Sample Size
C (Level 3 Units)
This is the number of level 3 units in group 1 (treatment group). The sample size for this group is equal to
Ceiling(C1 * K * M).
Examples of level 3 units are schools, clinics, hospitals, or cities.
A cross-sectional study might include schools as the level 3 units, classrooms as the level 2 units, and students are
the level 1 units.
A longitudinal study might include clinics as the level 3 units, patients as the level 2 units, and repeated
measurements are the level 1 units.
This value must be a positive integer.
You can enter a list of values such as "10 20 30". A separate analysis will be run for each element in the list.
K1 (Level 2 Units Assigned to Group 1)
Enter the average number of level 2 units per level 3 unit that are assigned to group 1 (treatment group). The
sample size for this group is equal to Ceiling(C * K1 * M).
Examples of level 2 units are classrooms or patients. A cross-sectional study might include schools as the level 3
units, classrooms as the level 2 units, and students are the level 1 units. A longitudinal study might include clinics
as the level 3 units, patients as the level 2 units, and repeated measurements are the level 1 units.
This value must be a positive number. Decimal values such as 4.5 can be entered.
You can enter a list of values such as "10 20 30". A separate analysis will be run for each element in the list.
K2 (Level 2 Units Assigned to Group 2)
This is the number of level 2 units per level 3 in group 2 (control group). The sample size for this group is equal
to Ceiling(C * K2 * M).
Examples of l2 units are classrooms or patients. A cross-sectional study might include schools as the level 3 units,
classrooms as the level 2 units, and students are the level 1 units. A longitudinal study might include clinics as the
level 3 units, patients as the level 2 units, and repeated measurements are the level 1 units.
This value must be a positive number. Decimal values such as 5.7 can be entered.
Using Multiples of K1
If you simply want a multiple of the value for group 1 (K1), you would enter the multiple followed by "K1", with
no blanks. If you want to use K1 directly, you do not have to enter the leading "1". For example, all of the
following are valid entries: K1, 2K1, 0.5K1, and 1.5K1.
You can use a list of values such as "10 20 30" or "K1 2K1 3K1".
M (Level 1 Units Per Level 2 Unit)
This is the average number of level 1 units in each level 2 unit. Examples of level 1 units are repeated
measurements or students.
A cross-sectional study might include schools as the level 3 units, classrooms as the level 2 units, and students are
the level 1 units. A longitudinal study might include clinics as the level 3 units, patients as the level 2 units, and
repeated measurements are the level 1 units.
This value must be a positive number that is at least 1.
It can be a decimal (fractional) number such as '2.7'. The resulting total number of level 1 units will be rounded up
to the next largest integer.
You can use a list of values such as "5 10 15". A separate analysis will be run for each element in the list.
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Effect Size
P1 Input Type
Indicate what type of values to enter to specify the effect size: P1 - P2. Regardless of the entry type chosen, the
test statistics used in the power and sample size calculations are the same. The value of P1 is calculated from the
value entered. This option is simply given for convenience in specifying the effect size.
The choices are
•

Proportions
Enter P1 (Group 1 Proportion|H1) and P2 (Group 2 Proportion).

•

Differences
Enter D1 (Difference|H1 = P1-P2) and P2 (Group 2 Proportion).

•

Ratios
Enter R1 (Ratio|H1 = P1/P2) and P2 (Group 2 Proportion).

•

Odds Ratios
Enter OR1 (Odds Ratio|H1 = Odds1/Odds2) and P2 (Group 2 Proportion).

P1 (Group 1 Proportion |H1)
Enter a value for the proportion in group 1 (the experimental or treatment group) under the alternative hypothesis,
H1. The power calculations assume that this is the actual value of the proportion.
You can enter a single value such as 0.1 or a series of values such as 0.1 0.2 0.3 or 0.1 to 0.9 by 0.1.
Note that values must be between zero and one and cannot be equal to P2.
D1 (Difference|H1 = P1 – P2)
This option specifies the difference between the two proportions under the alternative hypothesis, H1. This
difference is used with P2 to calculate the value of P1 using the formula: P1=Diff+P2.
The power calculations assume that P1 is the actual value of the proportion in group 1 (experimental or treatment
group).
You can enter a single value such as 0.05 or a series of values such as 0.03 0.05 0.10 or 0.01 to 0.05 by 0.01.
Differences must be between -1 and 1. They cannot take on the values -1, 0, or 1.
R1 (Ratio|H1 = P1/P2)
This option specifies the ratio between the two proportions P1 and P2. This ratio is used with P2 to calculate the
value of P1 using the formula: P1=(Ratio) x (P2).
The power calculations assume that P1 is the actual value of the proportion in group 1 (experimental or treatment
group).
You can enter a single value such as 0.5 or a series of values such as 0.5 0.6 0.7 0.8 or 1.25 to 2.0 by 0.25.
Ratios must be greater than zero. They cannot take on the value of one.
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OR1 (Ratio|H1 = Odds1/Odds2)
This option specifies the ratio of P1 and P2, where P1 is the proportion in group 1 under the alternative
hypothesis. This ratio is used with P2 to calculate the value of P1 using the formula: P1 = R1 x P2.The power
calculations assume that P1 is the actual value of the proportion in group 1 (experimental or treatment group).
You may enter a range of values such as 0.5 0.6 0.7 0.8 or 1.25 to 2.0 by 0.25. Ratios must be greater than zero.
They cannot take on the value of one.
P2 (Group 2 Proportion)
Enter a value for the proportion in group 2 (the control, baseline, standard, or reference group).
Values must be between 0 and 1.
You can enter a single value such as 0.1 or a series of values such as 0.1 0.2 0.3 or 0.1 to 0.5 by 0.1.

Effect Size – Within Level Correlations
ρ1 (Correlation Among Level 1 Units)
This is the correlation of each pair of level 1 units in a particular level 2 unit.
Possible values are from 0 to just below 1. For fixed slope models, ρ1 ≥ ρ2. Typical values are between 0.0001
and 0.5.
You may enter a single value or a list of values.
ρ2 (Correlation Among Level 2 Units)
This is the correlation of each pair of level 2 units in a particular level 3 unit.
Possible values are from 0 to just below 1. For fixed slope models, ρ1 ≥ ρ2. Typical values are between 0.0001
and 0.5.
You may enter a single value or a list of values.
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Example 1 – Calculating Power
Suppose that a three-level hierarchical design is planned in which there will be students (level-1) which are nested
in classrooms (level-2) which are nested in schools (level-3). This analysis will calculate the power for testing the
significance of the difference in proportions of two interventions. There will be one measurement per student and
treatments will be applied to schools (level-3 units).
The analysis will use a mixed logistic regression model. The following parameter settings are to be used for the
power analysis: P1 = 0.6; P2 = 0.5; ρ1 = 0.02; ρ2 = 0.01; C = 6; M = 5, 10; α = 0.05; and K1 = K2 = 5 to 20 by
5.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Mixed Models Tests for Two Proportions in a 3-Level Hierarchical Design (Level-2
Randomization) procedure window. You may then make the appropriate entries as listed below, or open
Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alpha ....................................................... 0.05
C (Level 3 Units) ..................................... 6
K1 (Level 2 Unit Assigned to Group 1) ... 5 10 15 20
K2 (Level 2 Unit Assigned to Group 2) ... K1
M (Level 1 Units Per Level 2 Unit) .......... 5 10
P1 Input Type ......................................... Proportions
P1 (Group 1 Proportion|H1) .................... 0.6
P2 (Group 2 Proportion) ......................... 0.5
ρ1 (Correlation Among Level 1 Units) .... 0.02
ρ2 (Correlation Among Level 2 Units) .... 0.01

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Comparing Two Proportions
H0: P1 = P2. H1: P1 ≠ P2
Grp 1
Grp 2
Lvl 3
Lvl 2
Lvl 2
Lvl 1
Total
Units
Units
Units
Units
Power
N
C
K1
K2
M
0.4029
300
6
5
5
5
0.6595
600
6
5
5
10
0.6802
600
6
10
10
5
0.9188
1200
6
10
10
10
0.8452
900
6
15
15
5
0.9844
1800
6
15
15
10
0.9303
1200
6
20
20
5
0.9974
2400
6
20
20
10

Grp 1
Prop
P1
0.6000
0.6000
0.6000
0.6000
0.6000
0.6000
0.6000
0.6000

Grp 2
Prop
P2
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000

Prop
Diff
P1-P2
0.1000
0.1000
0.1000
0.1000
0.1000
0.1000
0.1000
0.1000

Lvl 1
Corr
ρ1
0.020
0.020
0.020
0.020
0.020
0.020
0.020
0.020

Lvl 2
Corr
ρ2
0.010
0.010
0.010
0.010
0.010
0.010
0.010
0.010

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
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Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
N is the total number of level-1 units.
C is the number of level-3 units.
K1, K2 are the average number of level-2 units per level-3 unit assigned to groups 1 and 2, respectively.
M is the average number of level-1 units per level-2 unit.
P1 is the proportion for group 1 (treatment group) assuming the alternative hypothesis.
P2 is the proportion for group 2 (control group). This is the proportion in the standard, reference, baseline, or
control group.
Prop Diff = P1 - P2 is the difference in the group proportions assumed by the alternative hypothesis.
ρ1 is the correlation among level-1 units in a particular level-2 unit.
ρ2 is the correlation among level-2 units in a particular level-3 unit.
Alpha is the probability of rejecting a true null hypothesis, that is, rejecting when the means are actually equal.
Summary Statements
The total sample size of 300, which were obtained from 6 level-3 units with 5 level-2 units in
group one and 5 level-2 units in group two and an average of 5 level-1 units per level-2 unit,
achieve 40% power to detect a difference between the group proportions of at least 0.1000. The
proportion in group 1 is assumed to be 0.6000 under the alternative hypothesis. The proportion
in group 2 is 0.5000. The correlation of level-1 units within a level-2 unit is 0.020. The
correlation of level-2 units within a level-3 unit is 0.010. A test based on a mixed-effects
logistic regression is anticipated at a significance level of 0.050.

This report shows the power for each of the scenarios.

Plots Section

These plots show the power versus the level-2 count for the two values of M.
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Example 2 – Calculating Sample Size (Level-2 Units)
Continuing with the last example, suppose the researchers want to determine the number of level 2 needed to
achieve 90% power for the two values of M.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Mixed Models Tests for Two Proportions in a 3-Level Hierarchical Design (Level-2
Randomization) procedure window. You may then make the appropriate entries as listed below, or open
Example 2 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ K1 (Number Level 2 Units Per Level 3 Unit)
Power ...................................................... 0.90
Alpha ....................................................... 0.05
C (Level 3 Units) ..................................... 6
K2 (Level 2 Unit Assigned to Group 2) ... K1
M (Level 1 Units Per Level 2 Unit) .......... 5 10
P1 Input Type ......................................... Proportions
P1 (Group 1 Proportion|H1) .................... 0.6
P2 (Group 2 Proportion) ......................... 0.5
ρ1 (Correlation Among Level 1 Units) .... 0.02
ρ2 (Correlation Among Level 2 Units) .... 0.01

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Comparing Two Proportions
H0: P1 = P2. H1: P1 ≠ P2
Grp 1
Grp 2
Lvl 3
Lvl 2
Lvl 2
Lvl 1
Total
Units
Units
Units
Units
Power
N
C
K1
K2
M
0.9034
1080
6
18
18
5
0.9188
1200
6
10
10
10

Grp 1
Prop
P1
0.6000
0.6000

Grp 2
Prop
P2
0.5000
0.5000

Prop
Diff
P1-P2
0.1000
0.1000

Lvl 1
Corr
ρ1
0.020
0.020

Lvl 2
Corr
ρ2
0.010
0.010

Alpha
0.050
0.050

This report shows the power for each of the scenarios.
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Example 3 – Validation using Ahn, Heo, and Zhang (2015)
Ahn, Heo, and Zhang (2015) page 228 provide a table in which several scenarios are reported. We will validate
this procedure by the first row of the table. The following parameter settings were for the analysis: power = 0.80;
P1 = 0.5; P2 = 0.4; ρ1 = 0.1; ρ2 = 0.05; C = 24; M = 5; and α = 0.05. These settings resulted in a value of K1
and K2 (their N2(0)) of 4 and an attained power of 0.829.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Mixed Models Tests for Two Proportions in a 3-Level Hierarchical Design (Level-2
Randomization) procedure window. You may then make the appropriate entries as listed below, or open
Example 3 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ K1 (Number Level 2 Units Per Level 3 Unit)
Power ...................................................... 0.80
Alpha ....................................................... 0.05
C (Level 3 Units) ..................................... 24
K (Level 2 Units Per Level 3 Unit) .......... 4
M (Level 1 Units Per Level 2 Unit) .......... 5
P1 Input Type ......................................... Proportions
P1 (Group 1 Proportion|H1) .................... 0.5
P2 (Group 2 Proportion) ......................... 0.4
ρ1 (Correlation Among Level 1 Units) .... 0.1
ρ2 (Correlation Among Level 2 Units) .... 0.05

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Comparing Two Proportions
H0: P1 = P2. H1: P1 ≠ P2
Grp 1
Grp 2
Lvl 3
Lvl 2
Lvl 2
Lvl 1
Total
Units
Units
Units
Units
Power
N
C
K1
K2
M
0.8286
960
24
4
4
5

Grp 1
Prop
P1
0.5000

Grp 2
Prop
P2
0.4000

Prop
Diff
P1-P2
0.1000

Lvl 1
Corr
ρ1
0.100

Lvl 2
Corr
ρ2
0.050

Alpha
0.050

PASS calculates the same values of K1 and power: 4 and 0.8286.
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